STS Lead Worker Trapper Gadget
User Manual
March 1, 2015
Contents

1. Summary of Changes in G2 ......................................................... 4
   1.1. Overview ................................................................. 4
2. Gadget Basics ................................................................. 4
   2.1. How the Trapper Gadget Works ..................................... 4
   2.2. Trapping “Rules” for Valid Data Entry .......................... 5
   2.3. Gadget Care ............................................................ 5
   2.4. Keeping the Gadget Charged ....................................... 6
   2.5. Technical Support ..................................................... 6
3. PDA Specifications ............................................................ 7
   3.1. Overview ................................................................. 7
   3.2. Charging the Internal Batteries .................................... 7
   3.3. Adjusting Screen Brightness ........................................ 8
   3.4. Using the GPS Receiver .............................................. 8
   3.5. Resetting the PDA ..................................................... 9
   3.6. SD / microSD Cards ................................................... 9
4. Trap Placement ................................................................. 10
   4.1. Starting up the Gadget ............................................... 10
   4.2. Database Loading ..................................................... 10
   4.3. The Home Screen ..................................................... 10
   4.4. Compass ................................................................. 11
   4.5. Manual Lock ........................................................... 11
   4.6. The Placement Screen .............................................. 12
   4.7. Placement Confirmation ............................................. 12
   4.8. Omitting a Site ....................................................... 13
   4.9. Random Placements .................................................. 14
5. Trap Inspection ................................................................. 14
   5.1. Entering Inspection Data ............................................. 14
   5.2. Confirmation ........................................................... 15
   5.3. Inspection Distance .................................................. 15
   5.4. The History Function ................................................. 15
6. The Gadget Desktop Utilities ............................................... 16
   6.1. Overview ................................................................. 16
   6.2. Adding a Trapper ..................................................... 16
   6.3. Transferring Data ..................................................... 16
   6.4. Viewing Sites Files ................................................... 17
   6.5. Editing Sites Files .................................................... 18
   6.6. Viewing Activity Logs .............................................. 19
   6.7. Generating Navigation Files ...................................... 20
   6.8. Configuring FTP Uploads ........................................... 21
   6.9. Launching Atlas ...................................................... 21
   6.10. Version Checking ..................................................... 22
1. **Summary of Changes in G2**

1.1. **Overview**

No new features were added to the Gadget interface for the 2015 trapping season. The latest features added for the 2013 trapping season include:

1. Compass: A compass that displays the current cardinal direction as well as the bearing, an arrow pointing, to the current node (or trap site after a trap is set). This can be turned off in the CONF.txt file (compass=false).

2. Minimize program: The program can now be minimized during operation by clicking on the (minimize) button in the top left corner of the program. To restart, click on G2 link in the start menu or the G2 icon in the file explorer.

3. Satellite update: There is now a bar across the top of the program window that shows how recently G2 received a satellite update. The longer the bar is, from left to right, the shorter the time period since the last update. There are 10 increments to the bar length. The bar will turn red if G2 has not received a satellite update in 10 seconds.

4. History: Is now sorted starting with the most recent actions first.

5. Manual site lock: To turn off manual lock without conducting an action at a node / trap site, you have to go Manual Lock and select Auto. Manual lock is automatically turned off after an action is performed at a node / trap site.

2. **Gadget Basics**

2.1. **How the Trapper Gadget Works**

The Gadget essentially is a handheld computer/GPS system running custom trapping software written specifically for the STS Project.

1. The Gadget operates through referencing an internal database of information about trap sites for which the Gadget is responsible.

2. When powered on, the Gadget determines its location and searches its database for the trapping site closest to its current position and locks onto this site. This becomes the active site.

3. As the trapper drives or walks among sites, the Gadget continuously updates its location and monitors its database for the closest site. Thus, the active site changes as the trapper moves.

4. When a trapper indicates that the current active site is the one he/she wants to address, the Gadget refers to its database and determines the current status of that site with reference to trap placement and inspection information.

5. The trapper is then provided basic distance and relative orientation to the grid node or placed trap, depending on whether the activity is trap placement or inspection.

6. When the trapper is within the target circle of the active site (for trap placement) or at the previously placed trap (for trap inspection), the Gadget interface guides the trapper through legitimate STS activities built on STS protocols.

7. When the trap activity is committed, the Gadget updates its database, and this information becomes part of the permanent record for that site. The trapper cannot alter this information once it has been committed.

8. The trapper downloads trapping activity information to their computer or a supervisor’s computer, depending on the state trapping protocols, which is then submitted to the STS
database at Virginia Tech or Michigan State University. Gadget Desktop Utilities is used to facilitate file transfer to and from the Gadget and the database.

9. At any point in time, the Gadget database has a current and accurate record of the status of every trap site visited and thus leads the trapper through the trapping activities.

2.2. Trapping “Rules” for Valid Data Entry

1. You cannot perform any activity at a trap site not present in the Gadget database. A “random site” is automatically added to the database when created.

2. Only the site closest to the Gadget’s current location can be addressed, unless manual lock is used to select one of the five closest sites.

3. You cannot inspect a trap that has not been placed.

4. Only one trap can be placed at each site.

5. Traps may be placed outside target circles, but the Gadget displays a warning, requires confirmation, and records the activity.

6. Although traps may be inspected any number of times, only one final inspection is allowed.

7. Catch values (from 0 to 999) can be entered only if trap condition is “Good” or “Damaged.”

8. The Gadget will allow you to cancel out of any screen up until the point of committing that site activity to the Gadget database. Once a record is committed, it can only be changed by the supervisor.

2.3. Gadget Care

1. The Trapper Gadget is a handheld computer with an integrated GPS unit. Treat it as carefully as you would your laptop.

2. Keep the Gadget away from extreme heat and cold.


4. Do not run any other software besides the Gadget program or perform any other functions with the Gadget unit!

5. Always exit the Gadget software in the correct manner before powering off the Gadget. The red “X” button on the top right of the display will close the Gadget software, ensuring that all data is preserved before powering down or removing the SD card.
2.4. Keeping the Gadget Charged

It is critical that you do not let the Gadget unit exhaust its battery power. Keep the unit plugged into the cigarette lighter when in the vehicle and into a wall outlet when at home.

Remember! The Gadget will lose battery power when not in use and not connected to a power source. This means if you lay it down for a week, it could be dead when you want to use it again.

2.5. Technical Support

If you have problems with your Gadget in the field, you will generally report to your supervisor, who can help you fix the issue, or replace your hardware. If you need direct technical support, you can also contact the STS field support staff.

<table>
<thead>
<tr>
<th>Name</th>
<th>Affiliation</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brad Pogue</td>
<td>Virginia Tech</td>
<td>540-231-4461</td>
<td><a href="mailto:bgpogue@vt.edu">bgpogue@vt.edu</a></td>
</tr>
<tr>
<td>Denise Dodd</td>
<td>Virginia Tech</td>
<td>540-231-9979</td>
<td><a href="mailto:drdodd@vt.edu">drdodd@vt.edu</a></td>
</tr>
<tr>
<td>Andy Roberts</td>
<td>Virginia Tech</td>
<td>540-231-4615</td>
<td><a href="mailto:roberts@vt.edu">roberts@vt.edu</a></td>
</tr>
</tbody>
</table>
3. PDA Specifications

3.1. Overview

The Trapper Gadget software runs on a handheld computer, or PDA. The following guide will explain how to keep the batteries charged, adjust the screen brightness for maximum battery life and visibility, and how to reset the unit in case of a problem with the software.

3.2. Charging the Internal Batteries

The Trapper Gadget PDA includes an AC power adapter for charging the internal batteries. To recharge the PDA, connect the power adapter to the PDA. When you plug the AC adapter into an outlet, charging should begin automatically, and you should see the indicator light on the top right-hand corner of the PDA.

To check the charge state of the batteries, go to Start → Settings, and click on the System tab at the bottom of the window. Click on the Power icon, and you will see the percentage charge for the main battery and the backup battery, if there is one. The battery life for PDAs is between 4 and 12 hours, depending on the model. If you find that you are getting significantly less operational time than this, please contact technical support, as this may indicate an issue with the battery or charger.

You should keep your Gadget PDA charging when you are not using it, so that the batteries will be full when you are ready to take it into the field; even when not in active use, the internal functions of the PDA will still deplete the batteries. A fully drained battery will take several hours to recharge, so it is best to keep the PDA plugged into an AC power source when not in use, even if the batteries are relatively full.

Note that allowing the batteries to become completely drained will erase all settings from the PDA, and may require that the Gadget software be reinstalled. If the batteries in your unit become discharged, you should coordinate with your supervisor to set the Gadget up for field use again.
3.3. Adjusting Screen Brightness
You can adjust the brightness of the screen, depending on your location and power supply. To access the backlight settings, go to Start → Settings, and click on the System tab. Click on the Backlight icon, and you will see three tabs. If you click on the Brightness/Configure tab, you can set the backlight level using the slider controls.

Note that the higher the backlight level, the faster the batteries will be drained; to prolong battery life, you should keep the backlight brightness as low as possible.

3.4. Using the GPS Receiver

The majority of the Trapper Gadget PDAs have a built-in GPS receiver. Note that the GPS receiver can take several minutes to orient itself to the satellite network, particularly if it is transported a long distance while turned off. While the GPS is acquiring the satellite signal, it should be kept stationary, and you should always make sure that you have a good signal before moving to your next trap site.

1. For the Garmin iQue M5:
To activate the receiver, simply fold up the antenna on the back of the unit. When you are finished using the PDA, close any programs that are still running, fold down the GPS antenna, and power off the unit.

2. For the Dell Axim:
The Axim uses a CompactFlash (CF) GPS card that is inserted into the CF card slot at the top of the unit. To activate the unit, insert the GPS card and start G2. The GPS card can be left in the unit at all times. It is important not to plug or unplug the receiver while the Gadget software is running; doing so will lock up the program, and require a reset.

3. For the Mio, Pharos 565, SX Pad, and Trimble Juno (SB/SD/3B):
These units have internal receivers that will activate when a program initiates them.
3.5. Resetting the PDA

If the PDA locks up or becomes unresponsive while you are using it, you may need to reset the unit. The reset button is located on either the bottom, side, or back of the PDA, and is recessed into the housing. In order to reset your PDA, first remove the SD/microSD card from the slot in the unit. With the card ejected, use the stylus to press the reset button. You should see the screen go blank momentarily, then display a boot-up graphic. After a few seconds, this graphic should change to the normal desktop, and you can reinsert the card and restart the Gadget software.

If the PDA continues to freeze after resetting as described above, you may need to perform a “hard reset.” The “hard reset” uses the same procedure as above, but you must hold down a combination of buttons on the PDA while you push the reset button. Each model PDA has a different button combination, and you should contact technical support if a soft reset does not solve the problem.

Note that a “hard reset” will erase all settings from the PDA, and will require the Gadget software to be reinstalled.

3.6. SD / microSD Cards

Each PDA has a slot for an SD/MMC or microSD card, and a card should have been included with the unit. Note that the card must be in place in order for the Gadget software to function.

For the Garmin iQue M5, Dell Axim, Mio, Pharos 565, and Trimble Juno SB/SD units, the card can be removed by simply pushing in on the card edge; the socket is spring-loaded, and the card will be ejected and can then be removed from the slot. To reinsert the card, insert it into the slot and push in until it clicks.

For the SX Pad and Trimble Juno 3B units, the microSD card slot is located inside the battery compartment. These cards should not be removed to access files. They can be connected to a computer via USB, rather than using a card reader.

The SX Pad automatically connects as a removeable storage device via USB, however the Juno 3B requires a special utility to be activated when connecting to a computer. To ensure the utility is activated, go to Start > Programs and open the “WM5storage” program. Once open, click “Activate” in the lower left corner, if needed, then connect the USB cable to the computer. The Juno 3B should now be connected as a removeable storage device.

Please contact technical support if there are any issues.
4. Trap Placement

4.1. Starting up the Gadget

Turn the unit on with the on/off button at the top center of the Axim, iQue and Pharos, the bottom center of the SX Pad, or the left hand side of the Mio and Juno, and launch the G2 software. The G2 software is launched by tapping the start button on the display and choosing G2 from the drop down menu. If you do not see G2 listed in the start menu, select the “File Explorer” from the start menu, then SD card, and click on G2. When you start the G2 software, you will see a trapping area screen if more than one bid unit is loaded on the PDA. If there are multiple bid units, select the proper bid unit and select Load, otherwise G2 will automatically load the sites from the bid unit. Once the sites are loaded, you can begin trapping.

4.2. Database Loading

If there is only a single set of sites on your Gadget these will automatically load on startup.

If your supervisor has requested that you work in more than one trapping area then there may be multiple database (db) files loaded on your gadget. If there are multiple db files loaded then the “Select Trapping Area” window will open allowing you to select the proper db file for the Gadget to read from, based on which area you are working in on a given day.

You can also switch trapping areas while using G2. To switch to another bid unit with the proper set of sites, click on the “stoplight” button in the bottom-left corner of the home screen, then click “Trapping Area” and select the proper file for the area.

4.3. The Home Screen

Your current position and information on the closest site is displayed in the Home Screen. Also displayed is the distance and direction of the nearest site, and the site status.

When you enter the trap target circle, the Site icon will turn from red to green. As you move from
site to site, the Gadget will automatically “lock on” to the closest site.

Depending on what operations have been performed at a particular site, the Site icon may change: A tree indicates an unaddressed site; if a trap has been placed, the icon will display either a delta or milk carton image. To place a trap or perform an inspection, simply click on the Site icon. Once a trap has been inspected there will be a magnifying glass icon to the right of the trap icon.

4.4. Compass

The compass works while the gadget is moving and may not be on all deployed gadgets.

The cardinal directions (compass) will rotate as the gadget is moved to keep the compass correct. The large red arrow is the bearing to the current site node or placed trap and it will rotate in coordination with the compass.

If you have problems with the compass please contact technical support.

4.5. Manual Lock

At times, you may need to perform an operation at a site other than “nearest” site. In this case, you can use the Manual Lock feature to select one of the five nearest sites to your current location.

To switch to manual lock mode, click the “traffic light” icon at the bottom left of the screen, and select “Use Manual Lock” from the Extras menu. You will be given a choice of five sites, and when you choose one, the Gadget will “lock on” to that site, until you manually return to Auto Lock mode. If the site you need is not in the list, you will either have to move closer to that location (if possible), or make a note of the operation on paper. If you choose the wrong site go back to the
Manual Lock screen and either choose the correct one or you can choose to set the gadget back to Auto Lock.

A red lock symbol will appear to notify you that you are in manual lock mode. Once you have performed an action on the locked site G2 will revert back to Auto Lock mode.

### 4.6. The Placement Screen

When you click the Site icon for an unaddressed site, you will be prompted to place a trap. If you are outside of the target circle (the Site icon is red when you click it), a warning will be displayed. You can choose to either continue and place the trap outside of the circle or cancel and move closer to the site.

Once you reach the placement screen, you have several options. You can place a Milk Carton or Delta trap, or you can Omit the site if you are unable to place a trap in that location. Simply select the appropriate trap type you are placing, and select “Place trap”.

Note that the default trap type will be pre-selected for placements. You are free to change it if need be (for example, if you run out of delta traps and need to hang a milk carton).

#### 4.7. Placement Confirmation

Once you have selected “Place trap” a Confirmation screen will appear. Once you have reviewed the information on the Confirm screen and select “Ok”, the Gadget updates its database and you cannot change the record. Until you select “Ok” on the Confirm screen, you can Cancel out of all actions for this trap site.

After you confirm the operation, you will be returned to the Home screen, and the Sites icon will be updated to show that a trap has been placed (or that the site was omitted). If everything looks correct, you can record the information in your log, and proceed to the next site.
4.8. Omitting a Site

If you select “Omit site” from the Placement menu, the Gadget will ask for an omit reason. Select the Omit reason and the Confirmation screen will appear. The Confirmation and Status Screens will indicate your intent to omit a trap. Gadget will allow you to omit a site only if it is the “active site”, i.e., the closest site; you can also manually lock onto a site to omit it, if it is in the five closest sites to your current position. If you need to omit a site and cannot get close enough for Gadget to lock onto it, have your supervisor do this when you upload your trap data.
4.9. Random Placements

To place a trap at a random location, click on the “traffic light” at the bottom left of the Home screen. When you click on the “Random Trap” button, you will be able to select from the five closest quads to your current location; if none of these quads are correct, you can select “other”.

Once you confirm the creation of a random site, you will be forced to place a trap. To place a trap at the new site, simply follow the instructions for normal trap placement.

5. Trap Inspection

5.1. Entering Inspection Data

When G2 is “locked on” to a site where a trap has been placed, the Site icon will display an image of a trap, either delta or milk carton. When you click on the Site icon, you will be prompted to perform an inspection.

To perform an inspection of a trap, you will need to enter the trap condition, mark the inspection as either Midseason or Final, and enter the Moth Count. Note that if you do not enter a catch value, it
5.2. Confirmation
As with trap placement, the Confirmation Screen for inspections is your last chance to change your data. Selecting “Ok” here commits the information to the Gadget database and returns you to the Home screen. Selecting “Cancel” will return you to the Home screen without committing any data.

Once you have returned to the home screen. The inspection (magnifying glass) icon will appear for the inspected trap.

5.3. Inspection Distance
G2 will display a prompt if you attempt to perform an inspection that is greater than 100 meters from your current location, and will not allow the operation to be completed. Occasionally, you may receive this message even when you are closer than 100 meters to the trap site; this can be caused by a bad GPS signal, either during the inspection itself, or when the trap was placed. If you are unable to complete the inspection even when you are at the trap, simply write down the coordinates and trap information in your paper log, and inform your supervisor of the issue.

5.4. The History Function
If you want to review your placements and inspections, you can check the HISTORY screen. To access the trapping history, click on the “traffic light” button in the lower left corner of the Home screen, and choose HISTORY.

The HISTORY screen will display a summary of all the operations performed (placements, inspections, etc), since the last time the data was downloaded from the unit.
6. The Gadget Desktop Utilities

6.1. Overview

The Gadget Desktop Utilities (GDU) is a software package that runs on a desktop or laptop computer. The software is used to transfer and organize Gadget data files, upload them to the STS servers, and perform limited editing (such as omitting sites and marking traps inaccessible). The GDU also has some features to help with setting up a Gadget, including the generation of waypoints for navigation software, and loading new Sites files to the Gadget.

6.2. Adding a Trapper

Before you can transfer data from the SD card to your local computer, you need to choose which trapper the data belongs to. The trappers’ names and initials are stored in a drop-down list on the main GDU screen; clicking on the list will allow you to select a trapper, and any data you transfer from the SD card will be stored in that trapper’s folder on your local computer.

To add a new trapper to the list, simply click the “Add Trapper” button, and fill in the new initials and name. When you click OK, you will return to the main GDU screen, and the new trapper will be visible in the drop-down list. If you make a mistake, you can use the “Delete Trapper” button to take the currently selected trapper off the list. Any data that has already been transferred will not be deleted.

6.3. Transferring Data

The GDU will detect the SD card automatically when you insert it into the card reader; when the Gadget SD card is placed into the card reader, the “SD Card” text box will change from “No SD Card” to the drive letter where the card reader is mounted. Once this box displays a drive letter, you will be able to use the Sync command to transfer your data from the card to the computer.
When you “Sync” the SD card to the PC, the GDU will copy both the Sites file (“db.txt”) and the Activity Log (“trans log.txt”) from the SD card to the PC. A copy of the Activity Log will be placed in the Queue folder, and backup copies of both the Sites file and the Activity Log will be placed in the Trapper’s folder. In addition, the Activity Log will be copied to the “Backups” folder on the SD card.

Once the data transfer is complete, the GDU will automatically eject the card, and display a prompt indicating that it is safe to remove the SD card from the reader. Once the card has been ejected, the SD Card text box will display “No SD Card,” even if the physical card is still in the reader. Note that if you need to edit any data after completing the transfer (i.e., Omitting sites or marking trap locations inaccessible), you will have to remove and reinsert the card, so that the GDU can detect it again.

If you have enabled FTP Uploads in the Configuration menu, you will now receive a prompt to upload the file. If you are connected to the Internet and would like to upload your Activity Log now, simply click “Yes.” If you don’t have an Internet connection, or would rather upload the file later, click “No.” Note that if you have disabled FTP Uploads, you will not see this prompt when you transfer your data.

6.4. Viewing Sites Files
If you need to check or review the data from a Sites file, or make changes (i.e., Omitted Sites or Inaccessible Traps), you can do so by selecting Open Sites File from the File menu. This will open a new window, the “Sites File” window, where you can view and edit all of the Sites files on your machine, from each of your Trappers.
Within the Sites Files window is a toolstrip with a number of buttons; using these buttons, you can mark a Site as Inaccessible, Omit a Site, Undo any changes to the file, Save any changes to the file, or Print out the entire Sites file. Note that these functions will be disabled until you select and open a Sites file, and that the editing (Omit, Inaccessible, Undo, Save) functions are disabled unless an SD card is present in the card reader.

Once the Sites window is open, you can select from a list of all the Trappers’ folders on your computer. Selecting a trapper will display a list of all the available Sites files for that trapper. Selecting a file will load the data into the display, where you can scroll through, view, and edit it. Once a particular file is opened, the Editing and Printing features will be enabled (assuming that an SD card is inserted into the card reader).

### 6.5. Editing Sites Files

Once you have inserted the SD card and selected both a Trapper and a Sites file, you can make edits to the file using the Omit Site and Inaccessible Site buttons. To edit an entry, highlight the desired row in the table, and click either Omit Site or Inaccessible Site. You will be prompted to enter the
appropriate information (Omit Reason, Inspection Type, and UTM Zone).

Any rows you have edited will be highlighted in yellow. If you make a mistake, you can simply select the proper row, and use one of the edit buttons to reenter the data. If you wish to revert a row back to its original state (i.e., “Undo” an edit), simply select the proper row, and click on the Undo button.

If you close the Sites Files window, or attempt to select a new Sites file, you will be prompted to save any edits to the current file. Selecting “Yes” will write the edits to file, after which the “Undo” function cannot be used to revert the data. Selecting “No” will discard all changes, and close the window or load the newly selected file. Selecting “Cancel” will leave the window open and the current Sites file selected, preserving all edits but not saving them.

6.6. Viewing Activity Logs

If you need to check or review the data from an Activity Log, you can do so by selecting Open Activity Log from the File menu. This will open a new window, similar to the Sites File window, where you can view and edit all of the Activity Logs on your machine. You can view either the backup copies of each file (stored in the Trappers’ folders), or the files that will actually be uploaded (stored in the Queue folder).
Unlike the Sites Files windows, the Activity Log window does not allow you to edit data in an Activity Log; in general, there is no need to edit the Activity Log, unless something has gone wrong with the Gadget software or data transfer. If you find that there is a problem with a Log file, it is best to contact technical support, so that any underlying problems can be fixed.

### 6.7. Generating Navigation Files

You can generate navigation Waypoints for the Garmin M5 from your Sites files. From the File menu, select Generate Navigation Files. You should see the Navigation window appear. If you have a Gadget SD card inserted into the drive, you can use the Sites file on the card to generate the Navigation data. Otherwise, you can use any Sites file, stored in any location on your computer.

You will be prompted for a set of Sites files to use as input, as well as a location to save the output files. You can generate one file at a time, or select a group of files to process. Once you have generated the Navigation files, you can load them (along with the appropriate maps) to your PDA using the Garmin MapSource application.
6.8. Configuring FTP Uploads

You can change the FTP settings in the GDU by clicking on the Configuration button. In the Configuration window, you can enable or disable automatic FTP uploads, and change your default State and Email address. In order to send notifications to more than one email address, simply enter multiple addresses, separated by a semi-colon. Note that FTP uploading is disabled by default; if you would like the upload your files using the GDU, make sure that the Enabled box is checked, and that your State and email address(es) are entered correctly, then click Save Changes.

*If you have trouble with FTP uploads, switch the FTP mode from Active to Passive and try again. If this does not help, please contact Virginia Tech for assistance.

6.9. Launching Atlas

If you want to check your data in ATLAS, or if you prefer to upload the files using the GPS Uploader program, you can launch either of these from the GDU Run menu. Note that you will still need to open and process the file in Uploader/ATLAS as usual. Also, the menu links to the Uploader and ATLAS will be disabled unless you have already installed those programs on your machine.
6.10. Version Checking

If you need to determine which version of the GDU you have installed on your machine, you can find this information by clicking on the “Help” tab in the main menu. If you choose About, the GDU will display the About box, which contains the version of the program, contact information for technical support, and a link to the STS contact directory.